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1 RepDoc—A document editor for Rep Plus

RepDoc is a document editor for Rep Plus that supports typographic text, styles, embedded images,
page layout, and so on, similar to word processors such as OpenOffice, Word, and Pages.
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Figure 1: RepDoc document with RepGrid analyses—styling editor and tab ruler open



As illustrated in Figure 1, the textual output from Rep Plus analyses is a styled RepDoc docu-
ment that can be edited in RepDoc and exported to other document processors as part of a publica-
tion. Graphic analyses in RepNet can be copied and pasted, or dragged, to a RepDoc document such
as a research notebook.

The RepDoc user interface includes an integrated styling specifier and style editor which, are
accessible through a top panel of the document that can be slid open to provide styling functionality
(Fig. 1 top), and opened further to provide style definition and editing functionality (§4).

Documents are saved in XML, and can be copied and dragged, in whole or part, in RTF that pre-
serves their content and styling, and is accepted by most document processors. Figure 2 shows the
document content copied and pasted to Microsoft Word with the typography and layout preserved
(except for the the horizontal rules and boxes in the table which Word supports differently).
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Figure 2: RepDoc document copied and pasted to Microsoft Word



2  Opening, saving and creating RepDoc files

A blue grid icon shown on the right is used for a RepDoc file. It contains the full ty-

L
pographic specification of the document including the styles specified, the page size, :
margins, defined styles, text and images, and their styling. It also stores the state of the
document window when it is saved, its size and location, the mode of presentation and ReoDoc fi

epDoc file

whether the styling or styles editor are open. This state is re-established when it is opened.
The data is held in an XML text format that is both human and machine readable.

2.1 Opening a RepDoc file

Clicking on the Open button in the Document panel of the Rep Plus Manager window brings up a
dialog for opening a file, with document files indicated by their distinctive icons. If a file is selected
RepDoc will attempt to open it as a document, reporting an error if the data cannot be interpreted
as such.
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Figure 3: Opening a document file from the Manager Window

All Rep Plus files contain a file type identifier and document files may also be opened by using
the Open (command-O) or Open Recent commands in the File menu, double-clicking on a document
file, or dragging it to the Rep Plus application icon or Manager window.

2.2  Save, Save As

Selecting the Save option in the File menu or keying command-S, may be used to save the document
data to its existing file. The Save As option may be used to save the document to a new file.



3 Editing RepDoc documents

Text editing in RepDoc has been designed to support the affordances that have become common
to most document processors, and are likely to be so familiar that you can use it as you would your
usual document editor.

3.1 Text selection

Moving the mouse to any position in the text and clicking once will position a selection cursor at
that position. Dragging to, or shift-clicking at, another position will select the text between the two
positions. Double-clicking in a word selects it, and triple-clicking in a paragraph selects the sur-

rounding paragraph.

3.2 Styling

Keying command-I toggles italic styling on and off, command-B does so for bold. When the cursor is
within a word, or text has been selected text, the styling is applied to the entire word or selection.
RepDoc also supports named character and paragraph styles which may be applied through a
styling editor (§4), and defined/edited through a styles editor (§19).
Documents created by Rep Plus analyses have defined styles that are used to manage their pre-
sentation and layout.

3.3 Copy/paste and drag/drop

Copy and paste functionality behaves as expected, as does drag and drop. When text with named
styles is pasted or dragged into another document, if the named styles have not already been defined
in that document they are automatically added to it.

If a corresponding named style has been defined then it is used to restyle the text, which may
result in changed styling if the definitions of the style in the source and target documents are not the
same.



4 Styling editor

The styling editor may be opened in a pane at the top of document window (Fig. 1) by keying command-
Y or clicking in the dark rectangle at the top of the vertical scroll bar on the right of the document
window and dragging it down. It may be closed by keying command-Y or dragging the dark rectan-
gle up to the top.

Figure 4 shows the styling editor pane under Apple OS X and Microsoft Windows, with the text
format panel on the left, the paragraph format panel in the centre, and the document format panel
on the right. The first two provide options to apply styling to selected text or paragraphs a feature
at a time or as defined in document-wide named styles, and the last provides options to style the
entire document. At the extreme left and right are panels for infrequently adjusted parameters, drop

shadows (left), and page identifiers and default tabs (right).
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Figure 4: Styling editor pane under Apple OS X (top) and Microsoft Windows (bottom)

The editing controls are the same under OS X and Windows, except for the usual variations in
the representation of standard widgets. The role of each control is not labelled in detail, but mousing
over one brings up an explanation of what it controls and how it operates.

4.1 Text format panel

The text format panel shows the styling of the selection, or Arial E 12 a
at the insertion cursor if no text is selected, and allows this

styling to be modified. If a particular styling attribute is 8 U A s L a
not common to the entire selection this indicated in a way E T O a |
appropriate to the attribute: menu blank; text box empty; Text format >

check boxes and color swatches showing a horizontal bar.

The top row specifies the font and size; the second whether the text is bold, italic, underlined,
strikethrough, sub/superscript (3), or has extra character spacing; and the bottom row the text style,
if any, transparency, color, and background color, if any.

4.1.1 Font size and character spacing

The control at the top right specifies the font size is in points and may be changed either by typing
in the text box or by selecting from its its popup menu. The control below operates similarly and
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specifies any variation required in the character spacing as a percentage of the normal spacing. It is
normally zero but may have any negative or positive value.

4.1.2  'The subscript/superscript control

As shown in Figure 5, the subscript/superscript control has four possible states: none, subscript, su-
perscript, indefinite (Apple OS X representations on left, Microsoft Windows on right).

1 1 1 1 []1 [] 1 [1] 1 [m] 1

Figure 5: States of the sub/superscript control: none, subscript, superscript, indefinite

The first three states may be specified by clicking in the middle, bottom and top third of the con-
trol, respectively. The indefinite state is used to indicate that the selection has more than one sub-
script/superscript state, or that the styling editor does not define a style in terms of the subscript/su-
perscript state. The subscript/superscript control appearance mimics that of the check box widget of
the respective operating systems.

4.1.3  Using the swatches to specify colors

The text and text background colors may be changed by clicking in right hand side of the swatches
to bring up the color selection widget of the operating system, or in the left hand side to choose an
option in the menus that pop up (Fig. 6).
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Figure 6: Menu selection of text color (left) and background color (right)

The text color menu includes options at the top to use the default text color that is specified in
the document format panel or the last color selected by clicking any of the swatches. The default
text color (specified in the document panel) is indicated by a thick gray boundary around the swatch
with the current default color in the centre.

The background color menu includes an option to choose that there should be no background,
which is indicated in the swatch by a thick gray rectangle as shown in Figure 4.
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4.2 Paragraph format panel
The paragraph format panel shows the styling of the paragraph E c R I E 2

that includes the insertion cursor or selection, and allows this

styling to be modified. The top row specifies the paragraph align- Break 0 L 0jl 0
ment (left, centred or right), the line spacing (which can be frac- H 0
tional, e.g. 1.15), and the paragraph top margin in inches; the sec- Paragraph format =

ond whether the paragraph is preceded by a page break, the paragraph background color if any, the
first line indent (which can be negative to support hanging indents), and the left and right margins;
and the bottom row the paragraph style if any, and the bottom margin.

4.2.1 Indentation

The paragraph margins may be used to control the indentation of the first line and the width and
positioning of the paragraph. The left and right margins control the horizontal width and position.
The top and bottom margins control the gaps between paragraphs.

As shown in Figure 7, a first line indentation with a positive value indents the initial line of a
paragraph. A hanging indent that indents the remainder of the paragraph may be specified by giving

the first line indentation a negative value and the left margin a corresponding positive value.

A first line indentation with a positive value indents the E 2
initial line of a paragraph. A hanging indent that indents the
remainder of theparagraph may be specified by giving the first 30 ol 210
line indentation a negative value and the left margin a —
carresponding positive value H 0
A first line indentation with a positive value indents the initial .
line of a paragraph. A hanging indent that indents the 2
remainder of theparagraph may be specified by giving 230!l 30! 210
the first line indentation a negative value and the left
margin a corresponding positive value < 0
Figure 7: Indenting the first line or the later lines of a paragraph
4.3 Document format panel
The document format panel shows the styling and presentation op- 05 Preview E
tions for the entire document, The first row specifies the top margin 100 E
for the document in inches, the mode of presentation (print preview, 051 0.5 %
no pagination, no margins but text wrap, no margins and no wrap); 0.5 . |:| 1
the second row the left and right margins, the scale of the presenta- Document format

tion; and the third row the bottom margin, the default text color, the document background color
if any, and a check box (by the pilcrow) that specifies whether invisible features such as tabs, para-
graph terminators (returns), line terminators (soft returns), and page margins should be shown.



4.3.1 Modes of presentation and scaling

The four modes of presentation are for convenience in editing, and specify how the document will
be shown on the screen, not how it will be printed. The Preview mode shows the document as it will
be printed. No pagination is similar but does not show the margins between pages. No margins just
shows the text, wrapping the lines to fit the window. No wrap is similar but does does not wrap the
lines.

Scaling, or zooming, applies only to the first two modes and simply reduces or magnifies the ap-
pearance of the document, whilst continuing to support editing. Magnification is particularly useful
to aid the precise specification of tab positions in the ruler (§5.1).

4.3.2  Default text color and document background color

The default text color is applied to text whose color is specified in the paragraph format panel as
default text color. The document background color is applied to every page. As shown in Figure 8,
the two color swatches have an additional menu item, Invert, which reverses the default text and
page background colors.

iment

Match Arthur

Last color

Figure 8: Inverting default and background colors

4.4  Page ID and default tabs panel—titling, dating and numbering

The page ID and default tabs panel allows the pages of a document to be labelled with its name, date
when last saved and page number, and the default tab stop separation to be changed. The title (T,
date (D), and page (P) check boxes at the top determine whether the file name should be shown in
the header of each page, the date last saved on the left of the footer, and the page number on the right
of the footer. The default tab stop separation at the bottom is specified in inches and determines how
far apart default tab stops (§5.1) will be generated.

Figure 9 shows the header and footer of the document shown in Figure 1 when all three page ID
options are selected. They are shown in the default text font and printed as part of the document.
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Figure 9: Page header showing the file name, and footer showing the date last saved and page num-

ber

4.5 Shadow panel—specitying drop shadows

The shadow panel at far left of the styling editor pane (Fig. 4) is essentially part of the text format
panel. It allows selected text to be decorated with a drop shadow, usually a title in a larger font size.
This involves six parameters and is used infrequently so the capability is tucked away out of sight
when unused.

Drop shadows are intended to provide a three-dimensional effect by emulating a light source
projecting a shadow of the text as if were composed of opaque or transparent objects separated from
a reflecting surface. The parameters allow some of the phenomena resulting from the position and
angle of the light source and the characteristics of the reflecting surface to be emulated.

The top row specifies the offset in pixels and angle in degrees of the shadow; the second the blur-
ring radius in pixels and transparency as a percentage of full transparency; the third the size varia-
tion in the shadow as a percentage of the font size and the color of the shadow (which may specified
to be the same as that of the text).

Figure 10 shows some examples of drop shadows and the parameters specified to create them.
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Figure 10: Examples of drop shadows with the parameters creating them




5 Tables—tab stops, bars, rules, boxes and soft returns

The primary function of RepDoc in supporting Rep Plus is to present textual analyses in a style that
is consistent with that of the graphical analyses (as exemplified in Figure 1). This generally involves
laying out structured data in a tabular format that is created by adding a set of tab stops to a para-
graph that specify the position of tab characters within the text and their effect on the text that fol-
lows them.

The tab stops structure a line of text, and the overall tabular effect is created by terminating each
line of text by a soft return that creates a new line that is part of the same paragraph and subject to
layout through its tab stops, rather than a normal return that creates a new paragraph.

The tab stops are supplemented by graphical features that superimpose styled lines on the para-
graph in positions specified as for the tab stops, and provide visual separation and containment of the
tabular data.

Tab stop positions are specified relative to the left margin of the page, and only operate correctly if
the paragraph is left-aligned.

5.1 The Ruler—editing paragraph margins, tab stops, bars, rules, and boxes

A horizontal ruler control at the top of the page (Figure 11) may be shown or hidden by keying
command-R. It enables paragraph margins, first line indent, various types of tab stop, vertical bars,
horizontal rules and border boxes to be specified, entered and edited.
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involvement — remoteness
flexible — rigid

Figure 11: Ruler control editing the tabs, rules, bar, and box structuring a table

Figure 12 shows the text of the table before the specified tab stops, rule, bar and box are applied
to the paragraph in order to structure the text as a table. The check box to show invisible items
(§4.3) has been activated to show the control characters—the text spacing that is apparent results
from the default tab stops that are automatically generated after any specified ones.
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Figure 12: Text of Fig. 11 before the tab stops, etc, are applied—showing invisible items

5.1.1 Tab stop types

When a tab character is discovered as text is composed into lines it has a horizontal location rela-
tive to the left margin of the page. This is used to associate it with the first tab stop whose position is
at, or after, that location, and the tab itself assumes the properties of that tab stop, that is a position
relative to the left page margin, a type, a leader, if any, and a text style, if any.

The tab type (left, right, center, decimal) determines how the text following the tab will be lo-
cated relative to the tab position:

Left tab stop ' A left tab sets the location for the beginning of following text to be the position spec-
ified by the tab stop.

Right tab stop 91 A right tab sets the location for the end of the following text to be the position
specified by the tab stop, to the extent that this is possible without text overlap. The end of the
following text is defined as a terminator—another tab, a return, a soft return, or the end of the
text.

Center tab stop T A center tab sets the location for the center of the following text to be the posi-
tion specified by the tab stop, to the extent that this is possible without text overlap.

Decimal tab stop T A decimal tab is intended to align numeric data and sets the location for the
following text to have the decimal point, if any, immediately after the position specified by the
tab stop. If there is no decimal point, the decimal tab behaves as a right tab.

Figure 13 shows the four types of tab stop in action, individually and in combination. The top
three examples show the same text comprising three lines having two fields separated by a tab being
structured as a table by left, right and center tab stops. The fourth example shows the second field
containing numeric or text data to illustrate layout with a decimal tab. The bottom example shows
the four tab types being used in combination to layout construct matches in a perspicuous tabular
structure.
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Figure 13: Examples of tab stop layouts: left, right, center, decimal, mixed

5.1.2 'Tab stop leaders and styles

Tab leaders were introduced in typography primarily for use in tables of content to bridge the gap
between the text and the numbers by leading the eye across the page, but they have many other uses,
for example, as patterned horizontal rules that provide breaks between sections. The leader, if anyj is
defined in the tab stop as the character, or string of characters, to be used repetitively to fill the gap

in the text created by the tab. The text style for the leader may also be specified in the tab stop, or
applied to the selected leader string using the text format panel (§4.1)—the leader string behaves just
like any other text even though it is automatically generated.
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Figure 14: Examples of tab leaders
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The top 4 examples show the tab leaders commonly available in most document processors, mid-
line dots and dashes and base-line dots and dashes, each styled with a text color. The next 4 exam-
ples show styling and custom leader variations: dots with character spacing and grey color; back-
ground color, strikethrough and underline used to emulate a leader without one being specified; a
custom leader created with “<>” and another created with “+-” The final 2 examples show section
separators created through custom leaders using decorative fonts.

5.1.3 Ban, rule and box types

Tab stops control the presentation of the content of a table. They are supplemented by geometric
constructs that control the way that content is delimited and framed, vertical bars, horizontal rules
and rectangular boxes. The positions of these are shown in the ruler by appropriate symbols simi-
lar to those for tab stops. To help differentiate the two types of feature, tab stops are shown at the
bottom of the ruler and geometric features at the top.

Bar| A bar draws a vertical line from the top to the bottom of the paragraph (including any before
and/or after space) at the location specified in the ruler.

Rule " # A rule is specified by two symbols that specify its beginning location on the left and ending
on the right. A horizontal line is drawn between these location at the vertical center of any
empty line in the paragraph. The height of the empty line may be specified by setting the font
size for that line even though there is no text. Entering a space character will prevent the line
being drawn, for example, if one wants an empty line as a spacer.

Box[ 1 A box border is specified by two symbols that specify the location of its left and right sides.
Its top location is the top of the paragraph (including any before space), and its bottom that of
the paragraph (including any after space).

A text style may be applied to a bar, a rule end, or box end. The text color color specified will be
used in drawing the lines, and, if a background color is specified, it will be used to fill a box. Figure
11 shows how the combination of tab stops, a box, bar and rule may be used to create a table with
colored dividers, border and background.

5.2 Entering and editing tab stops, bars, rules, boxes, and leaders in the ruler

The ruler control shown in Figure 15 provides all the functionality to manage paragraph margin, first
line indent, tabs tops, bars, rules, boxes and leaders through a set of subcontrols responsive to the
mouse and keyboard.

+ 2> = ... _|':' L T 3 a91r e
None u 94 4% | variable content— specific content
like — dislike

Figure 15: The ruler control for entering and editing tab stops, bars, rules, boxes, and leaders
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5.2.1 Setting the leader, type, and style

At the top left, clicking the + enters the text entered in the text entry box to its right as a new leader,
and the - deletes the leader shown in the leader box on its right. The leader shown in this box may be
cycled through those available by clicking in the left of box to cycle backwards, and the right to cycle
forwards. The leader shown may also be selected by control/right-clicking in the box and selecting a
leader from a popup menu.

The box to the right of the leader controls shows a left tab stop, and may be cycled through the
available tab stop and geometric types by clicking in the left or right or control/right-clicking in the
box.

The menu underneath these controls may be used to select a text style that will apply to the tab
stop leader, if any, or the color of the box, bar or rule.

5.2.2  Tooltips as the mouse hovers over the ruler

Tooltips are used to provide information about the ruler controls as they are for all controls in Rep-
Doc. The main one for the ruler shows when the mouse is over the far right of the ruler. When it is
over the ruler itself the tooltip shows the exact position relative to the left margin, and when it hov-
ers over an item the specification of that item is shown and the item is hilighted in red.

F

- Ty A ;
w7 A | ;k_
[ I3 169 pt
k 2.35in 391 pt 391 pt
36 pt -18 p[. Decimal tab stop 5.43in 543 in
76 pt 0.5in 'F*-zﬁ_'” . Leader ..... Box end Rule end
1.06 in Left margin First line indent Style Value Style Construct Style Construct

Figure 16: Tooltips shown as the mouse cursor hovers over ruler items

The first line indent position is shown relative to the left margin, and the right paragraph mar-
gin is shown relative to the right margin, exactly as they are entered in the paragraph format panel
(§4.2).

If two items are at the same location, such as the box end and rule end items on the right, then one
item will highlight as the mouse moves from the the left to hover over them and the other as the mouse
moves from the right.

5.2.3 Entering a new tab stop, bar, box, or rule

New items may be entered in the ruler by moving the mouse over the ruler and clicking when the
tooltip shows the required location. For precise placement the scale can be increased to zoom the
page and the ruler. The properties of the item entered are those shown in the controls on the left
of the ruler, item type, style (if any), and leader (if any) for a tab stop, and these may be adjusted as

required.

If a control/right-click is used then a popup menu appears (Fig. 17) allowing an item to be en-
tered with a property defined from the menu, with the other properties having the default values:
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left tab stop, no leader, no style. This is useful when entering several items with the properties speci-
fied on the left, together with others that are different and specified from the popup menu.

Clear all

Tab Type > Left

Tab Leader > Center
Line Type > Decimal "
Style >

Figure 17: Popup menu for setting the properties of tab stops, bars, rules, and boxes

The top option offered by the popup menu is to clear all items. This is useful because when a new
paragraph is created it inherits all the properties of the preceding paragraph, including the tab stops,
and one may want to delete them.

5.2.4 Editing the properties of existing items

The position of an existing item may be changed by clicking on it and dragging it to a new position.
Other properties may be changed by control/right-clicking on it and selecting a new value for a
property in the popup menu (Fig. 17).

When a set of items defining the structure of a table has been specified, it may be useful to move
all of them together, for example, to center the table. If the shift-key is depressed whilst dragging one
item then the other items also move to maintain their relative positions.

The first line indent and left and right margins may also be adjusted by clicking and dragging.
Changes will be shown in the relevant fields in the paragraph format panel (§4.2). Note that when
the left margin is dragged the first line indent will move with it—the indent is relative to the left
margin and, hence, is not being changed. If the shift-key is depressed whilst dragging the left margin the
absolute position of the first line indent is not changed (effectively changing the value of the indent).

5.3 Soft returns—controlling line wrapping

The text in a paragraph delimited by its terminal return character is automatically broken in to lines
shorter than the page width at a space or dash character (en-dash, em-dash, minus-dash, underline).
Sometimes, particularly in tabular layouts, one wishes to wrap a line within a paragraph without
terminating the paragraph itself. This can be done by entering a soft return that causes an immediate
line wrap. Since a set of tab stops belong to a paragraph, this enables the positions tabular columns to
be adjusted by moving one tab stop.

A soft return may be entered by depressing the SHIFT key whilst keying the RETURN key.
Tabs, returns, and soft returns are invisible characters that manage the layout of the text rather than
its contents. They may be displayed for editing purposes by clicking in the check box labelled by a
pilcrow at the bottom right of the document format panel (§4.3), as illustrated in Figure 18.
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Computer manufacturer: Apple Computer manufacturer: . Apples.
Computer model:; Mac Pro (Late 2013) Computer model: +  Mac Pro (Late 2013).
Operating System: 0sSX 10.14.6 Operating System: : 03X 10.14.67

Figure 18: Text with tabs, returns, and soft returns—invisible (left), visible (right)

A tab character is shown by an arrow (—), a return by a pilcrow (1) and a soft return by a line

teed symbol («).
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6 Styles Editor

The styles editor comprises the character and paragraph formatting panels of the styling editor to-
gether with an additional definitional pane immediately below it as shown in Figure 19. The ruler is
also shown because tab stops, bars, boxes, and rules may form part of a paragraph style definition.

o A B adal Bs Bl Er B 0.5
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svi B [=] B v BEE] e B s 0.5
& shadow Text format = Paragraph format ' Document format
Specified character features Specified paragraph features Title
Font @ Size | /€S| | T/ |Sh [ Col Alignment Spacing Back pelete New
B @I U IS (|t Back I [ IL[IR[BEA |TS Update

Arial, 16 pts, Color #400000, Bold, Italic, Align center, Space after & pts

# = p

Figure 19: Styles editor for defining and editing character and paragraph styles

The styles editor may be opened by keying shift-command-Y or clicking in the dark rectangle at
the top of the vertical scroll bar on the right of the document window and dragging it down below
the styling pane. It may be closed to just show the styling pane by keying shift-command-Y, closed
completely by keying command-Y, or moved to the required position by dragging the dark rectangle.

It may also be opened by clicking blue arrowheads at the bottom right of the character and para-
graph format panes to edit character or paragraph styles, respectively. The relevant arrowhead will
rotate to point downwards and indicate what type of style is being edited. If a character style is being
edited the paragraph format panes and the paragraph features checkboxes are grayed out.

The editor displays the text or paragraph style selected in one of the two style menus, for delet-
ing, updating, or being used as the basis for a new style with a different name. If nothing is selected
in the menus then a new style may be created from scratch.

The styling properties are shown in the styling editor in the upper part, and, for paragraph styles,
in the ruler below. Those properties forming part of the style definition are determined by the check
boxes in the lower part. The style definition is shown in linguistic form in the text at the bottom
which changes as style is being defined.

There are interlocks between the styling editor and styles editor to maintain a consistent state,
and to support users in defining styles as they see fit. For example, selecting a style in the text styles
menu automatically rotates the arrow in the text format pane to point down and that in the para-
graph pane to point right, setting a style parameter value in the styling editor automatically checks
the check box in the styles editor which indicates that the parameter is part of the styles definition.
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6.1 Defining character styles

Character styles can comprise any combination of: font, size, character spacing, color and trans-
parency, and whether the text is bold, italic, underline, strikethrough, has a specified background

color, and a shadow (with its specified parameters).

0 A B 0.5 -
8] BT Bese aues@: cs - 0 05 05
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& shadow Text format Y Paragraph format [ Document format
Specified character features Specified paragraph features Construct
Font| |Sizel |CS |T! |ShEdCol Delete Mew
B | u 5 1 Back
Color Navy

Figure 20: Styes editor pane editing a character style

6.2 Defining paragraph styles

Paragraph styles are a superset of character styles and, in addition, can specify any combination of:
text alignment, line spacing, first line indent, left indent, right indent, before space, after space, and
tab stops, bars, rules, and boxes.
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begin, 2.74; Right, 3.99; Center, 4.11; Left, 4.22; Box end, Construct, 5.43; Rule end, Construct,
5.43

Match Constructs

Size Sh MNew

r “

-[JT\ |— ‘-|JT\|-’ 3 |I|*|I|.

Figure 21: Styes editor pane and ruler editing a paragraph style

6.3 The default paragraph style

If no paragraph style is specified for text being entered then the default paragraph style, named Nor-
mal, is automatically applied. It may be edited in the styles editor but its name cannot be changed.
This style is also used to revert styling to the default and should specify values for all the style param-

eters.
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Figure 22: Editing the default paragraph style, Normal

6.4 'The styling specification cascade

In order of decreasing priority, text styles may be specified directly in the character format panel, the
character style menu and the paragraph menu. This provides a cascade from the paragraph styling,
through the character styling to the directly specified styling, from generality to specificity. For ex-
ample, a header style at paragraph level might have a specific word or phrase rendered in italic or
color as specified in a character style or directly for that one instance.

6.5 Using styles

All the styling required in a document may be created in the styling editor. However, defined styles
may be used to ensure consistency between the way the roles of special parts of the text are indi-
cated, such as titles, subtitles, emphasized text, and so on. They also make editing of the text struc-
ture easier since changing a style definition automatically applies the new style throughout the text.

Rep Plus analyses presented in textual form are output as styled documents with the styles cre-
ated from those defined for the graphic output of the analyses so that there is consistency of content.
Users may be change the visual presentation by editing the styles, for example, to use larger fonts for
projection on a screen.

6.6 Styling a table of contents and a bibliography

Good examples of the use of styles are those used to create a table of contents and a bibliography in a

specified format.

A table of contents with a section number on the left, followed by a section title requires a para-
graph style and a tab leader connecting them to a page number on right may be styled with a para-
graph style defining the font name and size, the space after, a left tab to separate the number and
title, and a right tab to separate them from the page number (Fig. 23 top). The right tab specifies the
tab leader and, possible its style, for example a light grey color and a wider character spacing (Fig. 23
bottom). Figure 24 shows a table of contents and a bibliography formatted with appropriate styles.
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Figure 23: Table of contents and tab leader styles
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7 Embedding Figures

Images may be copied/pasted or drag/dropped into a RepDoc page from Rep Plus graphic analyses
or from other applications. Each image behaves as it it were a single text character.

Usually one places one or more images in a paragraph without text, and a caption, or captions,
if required, in another paragraph above or below that containing the image(s). Tabs may be used to
layout multiple images.

Images may be selected by clicking on them. Selected images are shown with a border and 3 re-
sizing handles at the right, bottom center, and bottom right as illustrated in Figure 25. Two images
have been entered side by side, the one on the left has been selected, and the cursor has been moved
into the bottom right handle.
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Figure 25: Selecting an image for resizing by clicking on it

If the mouse is clicked and dragged the cursor changes to a double arrow to indicate resizing and
a tooltip shows the width and height of the picture as a percentage of the original image size and in
pixels as illustrated in Figure 26.
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Figure 26: Resizing an image by dragging in a handle whilst maintaining its aspect ratio
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The width and height change together to maintain the aspect ration but if the alt/option-key
is held down whilst dragging the width and height can be changed independently as illustrated in
Figure 27.
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Figure 27: Resizing the dimensions inldependently by dragging with the alt/option-key depressed
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